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This is the second time in three months that I’ve patterned my title after
an amusement park ride. (The first was Data-Go-Round, in our December 2010 issue). Like a Merry-Go-Round, a Tilt-A-Whirl also goes
round and round without really getting anywhere; but it does so in a
much more complicated and chaotic fashion. That makes it a more fitting metaphor for this month’s article, too.
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As I begin writing this, there are thirty-two days to my deadline. You’d
think that would be plenty of time, wouldn’t you? In actual fact, it’s going to be close. I’ll probably need every single one of those days if I’m
to accomplish all of my objectives. Exactly what are those objectives?
Well, in Stage One, I have to make temporary back up files for the seven
“partitions” on the removable “320” GB data hard disk used by my main
computer. Each of those “partitions” measures from 41 to 43 GB in size,
and they’re currently all pretty full. (As I’ve explained before, those are
really seven drives in two partitions. One physical drive located in one
primary partition, plus six logical drives located in one extended partition, all in one hard disk possessing a true total capacity of 298 real
GB. As I’ve also explained before, Operating Systems actually interact
with various types of drives, not with partitions. However, in computer
parlance, “drive” has been used to describe a number of different things,
while “partition” has been used to describe just one thing. Thus, even
though it’s totally wrong, the word “partition” has supplanted the word
“drive” in popular usage. Therefore, I guess I’ll have to go along with
the majority from now on).
Once I’ve made those seven temporary backups, I have to do seven temporary test restorations. (After all, a backup isn’t a backup unless you
know that it can be successfully restored if necessary). While I’ll need
to preserve my seven backups for a little while longer, I won’t have to
save those restorations. I can wipe out each one just as soon as I’ve verified that it’s good. Only after all seven restorations have tested good can
I proceed to Stage Two: running SpinRite (my hard disk testing program) on each of my seven data partitions. Last month, I estimated that
it would take 16 to 17 hours to test each one of them. (I also said that I
didn’t write down whether or not I’d tested my 320 GB data hard disk
when I first got it two years ago. Now, just a little bit too late to fix my
previous article, I’ve found written confirmation that I did, in fact, test
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Dat-A-Whirl, continued
it; and that it tested perfectly). Only if SpinRite finds that
all seven partitions currently residing on that disk are still in
perfect condition can I proceed to Stage Three: figuring out
some way to easily, regularly and thoroughly back up all of
that data. Well, those are my plans, anyway. We’ll see what
actually happens.
Stage Zero, Gathering My “Tools”
So what are my options for Stage One? To hold backup
files for the estimated 260 GB of data in my seven partitions, I really have only one viable target: my “One
Terabyte” USB Expansion Drive. (It has a true capacity of
931.51 GB, and only 155.11 GB of that is currently in use).
While I don’t yet have anything that I would consider to be
a real backup program for data, I do have those drive imaging programs that I’ve examined recently. Of them, which
do I know for a fact can write their output files to a USB
hard disk? Clonezilla (CZ), Image for DOS (IFD) and Image for Linux (IFL). Which do I think can probably write to
a USB hard disk? FSArchiver (aka File System Archiver, or
FSA) and Partimage (aka Partition Image, or PI). When I
first tested PI (in Hold That Ghost, my article for the November 2007 issue of ACGNJ News), I described how I
mounted a DVD so that PI could access it. Surely, if I could
do that, I can figure out a way to let FSA and PI access a
USB disk. (Anybody out there who thought “Don’t call me
Shirley” should be both proud and ashamed of themselves).

Finally, which can’t write to a USB disk? That would be
Ghost for DOS. Since IFD can do it, it is possible. However, IFD boots TBOS (TeraByte Operating System,
pronounced tee-boss), its own proprietary DOS version; and
all the IFD connectivity functions seem to be built in. Thus,
I can’t “borrow” their USB driver, and I haven’t found a
corresponding driver for MS-DOS 8 (my Ghost boot
floppy’s current operating system) or FreeDOS 1.0 (my
only current alternative). So for now, anyway, Ghost for
DOS bites the dust.
That gives me only five imaging programs (CZ, FSA, IFD,
IFL and PI) to use on seven partitions. Now, I could just
double up on two of them; but I really should take this unexpected opportunity to look at some other programs that I
haven’t tested before (even though they involve the dreaded
“W” word). So I downloaded trial versions of Image for
Windows 2.61 (IFW) and Acronis True Image Home 2011
(ATI). Norton Ghost for Windows (GFW) is up to version
15.0, but they don’t seem to have a trial download. However, I still have my GFW 9.0 CD from 2004, when their
misleading advertisements made me think it also contained
the final release of Ghost for DOS. (Actually, it didn’t.
They just threw in a complete copy of their previous CD
(Norton Ghost 2003), which did contain both DOS and
Windows versions). The IFW download was 6.9 MB, the
ATI download was 159.3 MB, and the GFW 9.0 CD contains files totaling 466.7 MB; but that last figure is
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misleading, because a lot of that total is “extra” stuff that
Symantec Corporation (the manufacturer) added as filler.
Hardly anybody ever uses most of those files. (Though I
will admit that they do come in handy if you need them).
Now I’ve got eight imaging programs (ATI, CZ, FSA,
GFW, IFD, IFL, IFW and PI) to use on those seven partitions. Since IFD and IFL are pretty much identical as far as
user options are concerned, I’m going to let IFL sit this one
out. If all the others work right, that’s OK. If not, I’ve got a
“pinch hitter”.

of that 80 GB disk; and its files totaled just over 73 GB).
This brings us to another of my “must have” utilities, which
I don’t think I’ve ever mentioned by name before:
MD5summer.exe. That’s right! MD5summer.exe. A Windows program. Now, there are other MD5 sum generators
out there; but this one is so much better that there’s really
no comparison. In fact, if I hadn’t been able to run it under
Ubuntu through Wine (the Windows emulator), I might
have had to cancel my move to Linux altogether. (Perish
the thought). That’s how vital I consider this program to be.
Its author is Luke Pascoe from New Zealand. (His website
is www.md5summer.org). He’s released MD5summer under the
GNU GPL (General Public License), but so far he’s only
created Windows versions. (Oh well, maybe someday).

However, before I could even start Stage One, I needed to
find a target for the test restorations that I’ll have to perform for each of the seven test backups. Unfortunately, I
didn’t currently have an empty hard disk that was big
enough to receive any of my seven partitions. Therefore, I
had to clear a disk that was already in use. In
Data-Go-Round, I mentioned an almost full 80 GB IDE
hard disk (true capacity 74.53 GB) that I’d recently removed (for safe keeping) from my multi-use external case.
(That case was originally designed to hold an internal IDE
CD/DVD drive, but it also works with any IDE hard disk
just fine). I couldn’t immediately erase that disk, though. I
had to copy its files elsewhere first; and for that, too, I had
only one viable destination: my “One Terabyte” USB Expansion Drive again. So I created a directory there named
WD80_73G, and copied my files into it. (In case you were
wondering about that name, Western Digital was the maker

In this case, here’s how MD5summer worked: The opening
screen featured a directory tree for my computer. Under
Ubuntu, all mounted hard disk partitions are displayed as
subdirectories of the “media” directory. (I’m sorry, but explaining unmounted disks and/or other operating systems is
beyond the scope of this article). Below that tree were three
buttons: “Create sums”, “Verify sums”, and “About”. In
this case, I chose the subdirectory corresponding to my 80
GB hard disk, then pressed “Create sums”. That brought me
to the “Create list of files to sum” screen, which contained
two display areas. On the left was “Folders:” (although it
actually displayed both directory names and file names),
and on the right was “Number of Items:” (which also in-
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Dat-A-Whirl, continued
cluded a file counter). At the bottom left were four buttons:
“Select All”, “Clear List”, “Add”, and “Add recursively”.
At the bottom right were two buttons: “OK” and “Cancel”.
In my case, I pressed “Select All”, “Add recursively”
(which also added all the contents of every subdirectory selected), and “OK”. That brought me to the “MD5sums:
Generating...” screen, which contained three display areas.
First on the left was an unlabeled area only about a quarter
inch wide. Next to that was “File”, and on the right was
“MD5 Hash”. At startup, all of my selected filenames were
displayed on the left, with a white circle preceding each one
(occupying the space provided by that unlabeled area). As
the program ran, the screen scrolled downward. One at a
time, each white circle was colored amber as the checksum
for its associated file was being calculated. When that was
done, the circle was colored green, the newly generated
MD5 sum was displayed on the right, and the circle on the
following line was colored amber as my calculations
continued.
Before I started, my file browser informed me that my hard
disk contained 950 files in 31 directories, totaling 73.1 GB.
When MD5summer finished (58 minutes and 38 seconds
later), it produced a 58.7 KB output file made up of 950
lines, each of which contained a checksum and a filename
(including its complete directory/subdirectory path). When
prompted, I named that file WD80_73G.MD5. After that
(as I indicated two paragraphs above), I copied all the files

(including my new checksum file) from my 80 GB hard
disk to the new WD80_73G directory in my One Terabyte
USB Expansion Drive. That operation took about 1 hour
and 55 minutes. (Unfortunately, or maybe I should say “fortunately”, copy operations don’t display an exact hh:mm:ss
counter when they’ve completed their operations). After
that, I went into the new WD80_73G directory and double-clicked on its WD80_73G.MD5 file. That started
MD5summer and brought me directly to the “MD5sums:
Generating...” screen; but this time in “Verify sums” mode.
The screen was pretty much the same as described above,
except that in addition to the circles and filenames on the
left, all of the previously calculated checksums were also
displayed on the right at startup. As the program ran, the
screen scrolled downward as before. One at a time, each
white circle was colored amber as the checksum for its associated file was being re-calculated, and then compared to
the earlier version. This time, the circles were colored green
if their comparisons matched, or red if they didn’t. Obviously, I didn’t want any red circles; and luckily, when
MD5summer finished (67 minutes and 10 seconds later), I
didn’t get any. That cleared my 80 GB hard disk for re-use,
and I could proceed to Stage One at last. Or could I?
Before I actually made my first backup, though, I had to
create MD5 checksum files for each of my seven data partitions. (They’re what I’ll use to verify that each test
restoration came out correctly. So it will be much more
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convenient to have them contained in their corresponding
backups. This way, the proper file will already be present
in each test restoration, ready for use). Before I describe
that process, however, maybe I’d better talk a bit about
names first. When I first began using Ubuntu regularly, I
had quite a bit of difficulty figuring out which partition was
which. That’s because Ubuntu, or maybe Gnome (the desktop environment), or maybe Nautilus (the file browser), or
maybe even Linux itself (I’m not sure what the true culprit
was) hid their real names from me. (The primary partition
was sdb1, and the six logical partitions were sdb5 through
sdb10). Instead, they were identified only by their sizes.
Thus, I saw three instances of “41.8 GB Filesystem”, one of
“43.1 GB Filesystem”, and three of “43.2 GB Filesystem”;
and counting down from the top didn’t work, either, because they weren’t in numerical order. On the other hand,
Windows used the familiar “letter-colon” system, which it
inherited from DOS, and which can be traced even further
back to CP/M (Control Program for Microcomputers). I
needed identifiers that I could actually write inside my partitions. That way, they would always be the same, no
matter what changeable nomenclature was applied from the
outside. I found that in the optional volume labels. I’d used
them on my hard disks a lot back in the good old DOS
days, but hardly at all recently. As I’ve mentioned in previous articles, I gave my data partitions volume labels that
matched the drive letters originally assigned to them by my

old Windows XP SP2 system. After that, for instance, Windows identified the last logical partition as “K_DRIVE
(K:)”, Ubuntu identified it as “K_DRIVE”, and only Linux
low level partition-specific utilities identified it as sdb10.
Getting back to MD5summer, D_DRIVE (Linux name
sdb5) contains 14,811 files in 551 directories, totaling 41.4
GB; and its MD5 sum file was created in 39 minutes and 48
seconds. E_DRIVE (Linux name sdb6) contains 31,427
files in 79 directories, totaling 41.3 GB; and its MD5 sum
file was created in 46 minutes and 31 seconds. F_DRIVE
(Linux name sdb7) contains 57 files in 3 directories, totaling 42.0 GB; and its MD5 sum file was created in 29
minutes and 37 seconds. (The G: and H: drives in my old
XP system were virtual CD drives, so there weren’t any
corresponding G and H hard disk labels). I_DRIVE (Linux
name sdb8) contains 87 files in 3 directories, totaling 40.4
GB; and its MD5 sum file was created in 28 minutes and 45
seconds. J_DRIVE (Linux name sdb9) contains 149 files in
14 directories, totaling 33.5 GB; and its MD5 sum file was
created in 23 minutes and 45 seconds. K_DRIVE (Linux
name sdb10) contains 73 files in 4 directories, totaling 37.6
GB; and its MD5 sum file was created in 26 minutes and 59
seconds. L_DRIVE (Linux name sdb1) is a special case,
formatted in the NTFS file system, and occupying the position that would usually be the C: drive in an XP setup.
Because that XP C: drive was actually located on a completely separate hard disk, this partition was assigned the

Continued on page 5
Page 4

ACGNJ News

February 2011

Dat-A-Whirl, continued
higher drive letter L, even though it’s actually the first partition on the disk. It contains 11,171 files in 1,797
directories, totaling 35.8 GB; and its MD5 sum file was created in 37 minutes and 13 seconds.

40.1 GB. In Hold That Ghost, and (to a lesser extent) in
Something Spooky? (in our October 2009 issue), I gave
fairly detailed descriptions of CZ operations. Due to space
considerations, I won’t be repeating any of that here, either.

Stage One, Backup 1 of 7 (Image for DOS)

Then, I proceeded to back up sdb5 (D_DRIVE), using CZ.
After I booted CZ from its Linux live-CD, my total backup
time was 2 hours, 34 minutes, 33 seconds (and that’s without a byte-for-byte comparison). Looking on my Expansion
Drive, I found 21 sequentially named files: 20 measuring 2
GB each, and the last measuring 108.3 MB, for a total of

Stage One, Backup 3 of 7 (Partimage)
My next two backup imaging programs are both included
on System Rescue CD, another Linux live-CD. SRCD boots
to a command line rather than to a Graphical User Interface.
So I had to enter the startx command to launch the GUI,
which starts with a terminal window already open. However, before I could use it, I had to verify the names of my
source and destination drives. That’s because the newer peripheral drivers (which begin every name with an “sd”, not
just SCSI devices, like in the “good old days”) are not as
predictable as the older drivers (which began IDE names
with an “hd”). In the course of my research for this article, I
booted Linux at least a dozen times. Just once, my hard disk
names were reversed, so that my USB drive came in as
sdb1, while my data drive came in as sdc1, 5, 6, 7, 8, 9 and
10; but even that once was too much. The old “hd” drivers
were absolutely dependable.
So each time now, I had to run GParted (the Gnome Partition Editor) first, to verify the drive names, before I could
use those names to specify source and target. I did that from
the SRCD menu, which is accessed either by clicking on
the little icon in the bottom left hand corner of the screen,
or by right-clicking on an empty area of the screen. From
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that menu, I chose System. That launched a sub-menu containing GParted, which confirmed that my sources were
sdb6 (E_DRIVE) and sdb7 (F_DRIVE), and my destination
was sdc1. Now, the CZ live-CD had displayed a menu of all
available drives, and let me choose the one that I wanted to
mount as my destination for file creation. Then it generated
the real commands that mounted that drive “behind the
scenes”. (I didn’t know it at the time, but by doing that, CZ
was actually hiding something very important from me).
The SRCD live-CD doesn’t do stuff like that. I had to type
the required commands into the terminal window manually.
So I entered the same commands that I’d used successfully
for PI in Hold That Ghost, back in 2007. (The first command created the target directory, and the second command
mounted sdc1 as that directory).
mkdir /mnt/dest

be used instead. To be fair to the SRCD people, this information was displayed as the live-CD booted; but in the
background, and easy to miss. (In fact, I didn’t see it there
until after I’d already found out about ntfs-3g from another
source). To my mind, it should have been displayed in a
much more emphatic way, such as the electronic equivalent
of a giant flashing red neon sign; and maybe a recording of
the “red alert” siren from Star Trek playing along with it, as
well. I wasted a lot of time trying to use various commands
to change my file and/or directory access permissions before I stumbled upon this annoying bit of command line
trivia. Once I did, I entered the following commands. (The
first unmounted sdc1, and the second used the new command to re-mount it as read/write; and that’s right: it’s
umount, not unmount).
umount /dev/sdc1

mount /dev/sdc1 /mnt/dest
Then I got caught in a booby trap, because my USB Expansion Drive (which Seagate, its manufacturer, had formatted
in the NTFS file system) came up mounted as read-only.
When I tried to create a file there, it bombed; and it took me
quite a while to figure out why. It seems that the mount
command, which (presuming that it was typed in accurately) has always worked properly for the past forty-two
years (ever since UNIX was created), now doesn’t work
correctly for NTFS partitions. The command ntfs-3g must

ntfs-3g /dev/sdc1 /mnt/dest
PI can be launched from the SRCD menu, or from the command line. This time, I used my mouse to bring up that
menu, then I chose the System sub-menu as above. There,
going several lines below GParted, I clicked on Partimage
instead. PI opened a second terminal window, and filled it
with a colored display that looks like a graphical interface.
However, it’s not. It didn’t help that the mouse pointer also
stayed visible, and could be moved around inside that new
terminal window; but clicking on anything had absolutely

Finally ready to actually begin Stage One, I decided to proceed in Linux name order, starting with sdb1 (L_DRIVE);
and using IFD to back it up. After I booted IFD from its
floppy, my total backup time was 1 hour, 48 minutes, 12
seconds. However, that included a byte-for-byte comparison. The time for output file creation only was 54 minutes,
35 seconds. Looking on my USB Expansion Drive, I found
17 sequentially named files: 16 measuring 2 GB each, and
the last measuring 1.3 GB, for a total of 33.3 GB. (In our
November 2009 issue, in New Blood, I gave extremely extensive descriptions of both backup and restore operations
as performed by IFD. Since that information is still readily
available, I’m saving space in this article by not repeating it
here).
Stage One, Backup 2 of 7 (Clonezilla)

Continued on page 6

February 2011

ACGNJ News

Page 5

Dat-A-Whirl, continued
no effect, because this is a text mode interface. Thus, it has
to be navigated from the keyboard, using the Tab and arrow
keys. On the first screen, I selected sdb6 as the “Partition to
save/restore”. I typed in “/mnt/dest/E-PI-SRTEST1” as the
“Image file to create/use”, and I selected “Save partition
into a new image file” as the “Action to be done”. Then I
pressed F5 (Next). A second screen came up, listing further
options; but I accepted all default entries, and pressed F5
again. Then I had to hit “OK” twice more before PI actually
started. My total backup time was 2 hours, 38 minutes, 48
seconds. When I looked at my USB drive, I found 20 sequentially named files: 19 measuring 2 GB each, and the
last measuring 556.8 MB, for a total of 38.5 GB.
Stage One, Backup 4 of 7 (FSArchiver)
Since I could proceed to FSA without rebooting, my USB
drive was still mounted, and I didn’t need to repeat any of
my earlier commands. So I just entered the following in my
terminal window. It’s very similar to what I used the last
time I tested FSA (in Wrap It Up, my article in our December 2009 issue). The only new addition was -s 2000, which
split the output file into 2 GB file segments, like the other
programs did.
fsarchiver savefs -s 2000 /mnt/dest/F-FSA-SRTEST1.fsa
/dev/sdb7
Unfortunately, I got the following error message:
oper_save.c#1032,filesystem_mount_partition(): cannot
mount partition [/dev/sdb7]: filesystem may not be supported by either fsarchiver or the kernel

I changed the end of the command to sdb6, and then re-ran
it; and I got the same error message again. I got a fairly
similar message in Wrap It Up, when I tried to back up sda5
(which was a Linux swap partition). At the time, I thought
that FSA just didn’t want to back up a swap partition. That
assumption did make sense, because no imaging program
should ever really want to make an image of a Linux swap
partition. Like the Windows swap file, a Linux swap partition (and the information contained therein) is totally
useless once its associated operating system has stopped
running. Now, though, it seems more likely that FSA actually can’t handle any logical partition. In order to test this
new theory, I changed the command as follows, to make it
back up my only non-logical drive: sdb1 (L_DRIVE):
fsarchiver savefs -s 2000 /mnt/dest/L-FSA-SRTEST1.fsa
/dev/sdb1
Then it ran. So I guess that FSA is even more “not ready for
prime time” than I’d previously thought. In addition to this
newly discovered deficiency, it still hasn’t advanced to the
point where it gives any sort of progress indication. Not
even a simple “running” message on the command line. As
I noted in Wrap It Up, if it wasn’t for the way my drive indicator lights began flashing like crazy, I wouldn’t even
have known it was running. The cursor just sat there empty
until FSA finally finished. Then, it displayed a “successfully processed” message, but no “elapsed time” indicator.
When I looked at my USB drive, I found 17 sequentially
named files: 16 measuring 2 GB each, and the last measuring 84.0 MB, for a total of 32.1 GB. Subtracting the
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creation time of the first file from the completion time of
the last file gave me a duration of 2 hours, 13 seconds.
That’s as close as I’m going to get to my total backup time.

before, verifying that my USB disk came in as sdc1, and
my empty target disk came in as sdb. While in GParted, I
created an FAT32 primary partition on my target disk,
which came in as sdb1. (From previous experience, I knew
that FSA would bomb if I didn’t give it something to overwrite). Then I entered the following in my terminal
window. (That third line is very similar to the restore command I’d used previously, in Wrap It Up).
mkdir /mnt/dest

Stage One, Repeat Backup 1 (Image for DOS)
This still left me without a backup of sdb7 (F_DRIVE),
however. So I made it with IFD. After I booted from the
IFD floppy and ran IFD again, my elapsed time was 1 hour,
5 minutes, 32 seconds. This time, I didn’t check off the
“Validate Byte-for-Byte” option, so that’s the actual time it
took for IFD to make its backup. Looking at my USB Expansion Drive, I found 21 sequentially named files: 20
measuring 2 GB each, and the last one measuring 649.3
MB, for a total of 40.6 GB.
Stage One, Restoration 1 (FSArchiver)
Before venturing into unknown Windows territory, I decided to perform test restorations of the four backups that
I’d already made. I proceeded in Linux name order, starting
with the sdb1 (L_DRIVE) backup that I made using FSA. (I
didn’t restore the earlier sdb1 backup that I’d done with
IFD; but I also didn’t delete it from my USB drive yet either, “just in case”). In preparation, I removed my Ubuntu
boot drawer and my data drawer from my computer, inserted the drawer containing my spare 80 GB target hard
disk, connected my USB expansion Drive, and booted from
the SRCD live-CD. Once at the desktop, I ran GParted as

ntfs-3g /dev/sdc1 /mnt/dest
fsarchiver
restfs
/mnt/dest/L-FSA-SRTEST1.fsa
id=0,dest=/dev/sdb1
As before, FSA gave absolutely no progress indication on
the screen as it ran. This time, I got a book and sat like a
lump in front of the computer, reading (and occasionally
glancing at the screen). A change in the sounds coming
from the hard disks alerted me that something was happening. I saw the “successfully processed” message appear, and
I noted the time according to my wrist watch. Thus, the following FSA restore time is as accurate as it’s possible to
measure manually: 43 minutes and 30 seconds. Then, I shut
down my computer, removed the SRCD live-CD, disconnected the USB drive, re-inserted the drawer containing my
Ubuntu operating system, and re-started the computer. After Ubuntu booted, I accessed the newly restored partition

Continued on page 7

Page 6

ACGNJ News

February 2011

Dat-A-Whirl, continued
on my spare hard disk, found the MD5 sum file, and double-clicked on it. 39 minutes and 0 seconds later,
MD5summer finished with no errors. So that’s one down,
three to go. (Be aware that I did also have to do all of the
drawer and CD removals and re-insertions described above
for each of the other three restorations. I’m just going to
omit most of those details below).

have to adjust to doing it their way. So I went back and
changed to restoreparts mode, and this time my backup was
listed, so I selected it, and then proceeded. Unfortunately, I
soon got an error message:
Error! No unmounted partitions are found! To use
Clonezilla to save or clone a partition, the source partition
must be unmounted!
Obviously, this message was written with backup operaStage One, Restoration 2 (Clonezilla)
tions in mind, but its meaning is clear enough. CZ wants
Next up was sdb5 (D_DRIVE), made by CZ. In its “Select
there to be an unmounted partition in my target drive. In
mode” menu, CZ offers two options involving restoration:
other words, when doing a partition restoration, CZ does
restoredisk (“Restore an image to local disk”) and
need something to overwrite. So I ran GParted, and created
restoreparts (“Restore an image to local partitions”). Bea single primary partition, which came in as sdb1. I then
cause Ghost for DOS (my standard for all comparisons) had proceeded as before, until I got a different error message:
no problem restoring the backup of any single partition to
Failed to restore partition image file
an entire hard disk, I tried the “local disk” option first; and
/home/partimage/D-CZ-SRTEST-2010-12-27-06-img/sdb1
since CZ can restore the entire contents of a full hard disk
backup to a completely empty target disk, I left my spare 80 * to /dev/sdb1! Maybe this image is corrupt!
GB disk totally unallocated. Unfortunately, when I got to
Well, that was some progress, anyway. At least this error
the “Choose the image file to restore” menu, the name of
message actually applied to the restore operation that I was
my backup just wasn’t listed as one of the available
trying to perform. Or did it? Note that star (which they put
choices. I guess that CZ can differentiate between a “whole there, not me). Right before it, they displayed a file name
disk” and an “only some partitions” backup, and refuses to
ending with “sdb1”; but a correct transcription of my
list the latter when in restoredisk mode. To my mind, that’s backup’s name would have ended in “sdb5”. Could CZ be
a sign of “less than flexible” thinking on the part of the CZ trying to tell me something? Forget about any degree of
developers; but, after all, it’s their program. They can write flexibility. Let’s try “rigid” thinking on the part of the CZ
it any way they want, and (if I decide to keep using it), I’ll
developers. So I went back to GParted, deleted my primary
Continued above right
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partition, and replaced it with a logical partition, which
came in as sdb5. Then, CZ ran. My total restore time was 1
hour, 32 minutes, 44 seconds. Running the MD5 sum file
under Ubuntu, my total compare time was 43 minutes, 42
seconds, with no errors. Two down, two to go.

Then I pressed F5 (Next). A second screen came up, listing
further options; but I accepted all the default entries, and
just pressed F5 again. Then I had to hit “OK” once and
“Yes” once before PI started. My total restore time was 32
minutes, 4 seconds. (Be assured that time value is not a
typo). Running the MD5 sum file under Ubuntu, my total
compare time was 50 minutes, 37 seconds, with no errors.
That short restore time bothered me so much that I re-did it
all over again, this time mounting sdc1 using the ntfs-3g
command. (My working theory was that maybe that one
time wasn’t too fast. Maybe those previous restore times
for FSA and CZ were too slow instead, possibly because
ntfs-3g somehow demanded more “overhead”). However,
my second restore time was 33 minutes, 28 seconds. Almost as fast as before, and still (as you’ll see in a minute)
just a tiny bit faster than IFD as well. My second MD5
compare time was 48 minutes, 56 seconds. A tad faster, but
similar to before. Imagine that. Both times, it took
MD5summer significantly longer to read this partition than
it took PI to write it. How counter-intuitive. I can’t explain
these anomalous PI times; but then again, I don’t have to.
They’re repeatable and verifiable. So they’ll just have to be
accepted “as-is”. Weird! Anyway, that’s three down, and
one to go.

Stage One, Restoration 3 (Partimage)
Next up was sdb6 (E_DRIVE), made by PI. So I booted
from the SRCD live-CD once more, and ran GParted as before. After verifying that my USB disk came in as sdc1,
and my target disk came in as sdb5, I used GParted to delete sdb5. Then, I created an FAT32 primary partition in its
place, which came in as sdb1. (Because I knew that PI
would also bomb if I didn’t give it something to overwrite).
Then I entered the following commands in my terminal
window. (I used mount because I wanted to see if I could,
in fact, read NTFS partition sdc1 without using ntfs-3g).
mkdir /mnt/dest
mount /dev/sdc1 /mnt/dest
partimage
That third line launched PI from the command line. The
only difference from before was that, instead of opening a
second terminal window, PI took over the existing window
instead. On the first screen, I selected sdb1 as the “Partition
to save/restore”. I typed in “/mnt/dest/E-PI-SRTEST1.000”
as the “Image file to create/use”, and I selected “Restore
partition from an image file” as the “Action to be done”.

Stage One, Restoration 4 (Image for DOS)
Last up was sdb7 (F_DRIVE), made by IFD. I wanted to
try IFD with a completely empty target disk, so I deleted

Continued on page 8
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Dat-A-Whirl, continued
the existing partition and left my spare 80 GB disk totally
unallocated. Then, I booted from the IFD floppy and tried
to restore my partition; and it worked! My elapsed time was
37 minutes, 18 seconds. (I also didn’t check “Validate
Byte-for-Byte” , so that’s my true total restoration time).
Running the MD5 sum file under Ubuntu, my total compare
time was 33 minutes, 40 seconds, with no errors. That’s
four down, with Windows to go. However, before I could
proceed into Windows World, there was one more thing I
had to do. I do have an existing removable drive drawer for
Windows; but I didn’t want to unnecessarily “taint” it by installing programs on it that I don’t intend to keep. (Even
though it is already “polluted” by XP). So I pulled IFL off
the “bench”, and used it to make a backup of that drive.
Then, I restored that backup to a spare 40 GB hard disk. (At
37.27 real GB, it was just slightly too small to be used as
the target for my data partition restorations; but it had
plenty of room to be a “stunt double” for my XP drive).

right, that’s it: a humongous blizzard! Furthermore, this article itself has also grown humongous. At this point, it’s
over five and a half thousand words long. Even though I’ve
now decided to put Stage Three off until next month, it
could still wind up being a record breaker. If I can ever get
it done, that is. So I’d better “get on the stick”.
Stage One (Abrupt Conclusion)

Here, let’s take a time check. As I’m typing this, it’s now
19 days to my deadline. Therefore, from the time I first
started, it’s taken me fourteen days to get this far. That’s
more than a third of my originally available time gone, and
I’m only a little more than halfway through Stage One. In
my defense, I must say those were a particularly busy two
weeks, containing Christmas Eve, Christmas Day, New
Year’s Eve, New Years Day; and, I seem to recall, wasn’t
there something else? What could it have been? Oh yeah,

I did finish Stage One and Stage Two on time. Really, I did.
As you’ll see next month, I actually finished with time to
spare, five days before my deadline; and furthermore, I did
exceed 10,000 words: 10,043 (containing 47,144 characters) according to MS Word, and 10,269 (containing 57,110
characters) according to my word processor of choice,
OpenOffice.org. Consulting Abiword (another Linux word
processor), I got a clue as to what those character count differences might be. Abiword said; “Words: 10,271.
Characters (with spaces): 57,112. Characters (no spaces):
47,146. However, note that its totals don’t quite match the
others, either. As to the difference in total words, my working theory for the past few years has been that OO.o and
Word count hyphens and underscores differently; but I’ve
never been able to “nail it down” for sure. Oh, well, maybe
someday. As for now, it just makes more sense to split this
article in half, rather than to go for the record. (Oh, well,
maybe someday on that, too).
See you next month. :

Continued above right
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Book Review — Windows 7: The Definitive Guide
The Essential Resource for Professionals and Power Users

Reviewed by Elsie Smith (lcms (at) pacbell.net), PC Community, CA (www.pcc.org)
you’ll be able to apply them to your computer regardless of
This is the kind of how-to book that anyone-regardless of
skill level-can read from cover to cover and walk away with which edition of Windows 7 you are using.”
a wealth of knowledge about the subject at hand.
* Set up, customize, and tune Windows 7-Optimize its
This book provides everything you need to manage and
appearance and performance, install software - what has
maintain Windows 7. You’ll learn all of the features and
changed and what you need to know, customize your
enhancements in complete detail, along with specifics for
hardware, and install printers, scanners, and faxes
configuring the operating system to put you in full control.
* Manage your files and data-Search your computer
Bestselling author and Windows expert William Stanek
more efficiently, secure your data, share and collaborate,
doesn’t just show you the steps you need to follow, he also
and get the most out of optional programs such as
tells you how features work, why they work, and how you
Windows Live Mail
can customize them to meet your needs. You’ll also learn
* Master your digital media-Create media libraries,
why you may want to use certain features of the operating
manage digital pictures and videos, make DVDs, and
system and when to use other features to resolve any probcreate movies
lems you are having. Learn how to squeeze every bit of
* Get connected and start networking-Set up a home or
power out of Windows 7 to take full advantage of its
small-office network, conquer Internet Explorer, and
features and programs.
master on-the-go networking
When asked about the user level, Stanek replied: “This
* Protect your computer-Keep your family safe while on
book doesn’t focus on a specific user level. This isn’t a
the Internet, navigate the computer security maze, and
lightweight beginner book or a book written exclusively for
configure Windows 7’s protection features
developers or administrators. Regardless of whether you are
a beginning, power user, or seasoned professional, many of
* Manage and support Windows 7 systems-Configure
user accounts, disks and drives, troubleshoot and handle
the concepts in this book will be valuable to you. And
Continued on page 9
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Windows 7: The Definitive Guide, continued
routine maintenance, and resolve advanced support and
recovery issues
* Learn advanced tips & techniques-Manage the
Windows boot environment, explore Group Policy, and
much more
Product Information
Windows 7: The Definitive Guide
The Essential Resource for Professionals and Power Users
By William R. Stanek
O’Reilly Media, Inc.
http://www.oreilly.com

800-998-9938
List Price: O’Reilly Media: $59.99
UG Price $39.00 at: http://www.oreilly.com/store/
Free Online Edition: To try our Safari and the online edition of Windows 7: The Definitive Guide for 45 days, go to
http://www.oreilly.com/go/safarienabled and enter the coupon code shown on the last page of your book. To see the
complete Safari Library visit: http://safari.oreilly.com
This article has been obtained from APCUG with the author’s permission for publication by APCUG member
groups; all other uses require the permission of the author
(see e-mail address above). :
Continued above right
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PCmover

George Harding (Georgehardingsbd (at) earthlink.net), Tucson Computer Society, AZ (www.aztcs.org)
Laplink has had PCmover available for many years. Its purpose is to successfully transfer your data and programs from
an old computer to a new one. The data part of the transfer
is easy enough, in fact, Microsoft has an application called
Easy Transfer that will do that part. However, to transfer the
programs part is difficult. You usually have to install the
original programs on the new computer, and then update
them as necessary, which may take a long time
The PCmover process has been adapted to include the tricky
process of upgrading from XP to Window 7. As you probably know, Microsoft requires you to do a “clean” install
(format the hard drive, then install) if you are running XP,
then reinstall and update all your programs. I tried the
PCmover process in an update from XP to Window 7.
Overall, I would say it was a remarkable success. Before
you start doing an upgrade, it’s wise to run Microsoft’s
Upgrade Advisor, available at Microsoft’s site.
The first step, of course, is to make at least one complete
backup of your system – not just the data files, but the entire
partition in which XP is running. Some tech people even advise making two complete backups and having them
verified by the backup software.

The next step is to download and install PCmover. You can
download it at www.laplink.com/PCmover. Once downloaded,
you install it just like any other application. Laplink advises
that you turn off any screen savers and power-saving settings. For laptops keep the power plug in. Your computer
must stay awake during the entire procedure. They also recommend disabling anti-virus, spyware and similar
applications because they probably won’t be transferred
correctly; you’ll have to reinstall them after the upgrade.
Next, you run PCmover. You will need a serial number in
order to run the program, which you should get when you
download the program. The next screen of the program
shows several choices for method of migration. You should
choose the Windows 7 Upgrade Assistant method.
You can choose to migrate all users or only chosen ones.
You’ll usually choose all. Next, you’ll be presented with a
list of all your hard drives and partitions. You’ll only want
to migrate the partition/drive which has XP. Next you can
exclude certain file types. You probably won’t want to
transfer the listed types, but it won’t hurt anything if you do
transfer them.

Continued on page 10
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PCmover, continued
Next is a scan for applications. You’ll get a list of all the
applications on your computer. I got 112 in my list. You
may deselect any of these which you don’t want to migrate.
I left them all checked.
The next step creates the list of applications you have chosen, and then asks you what name to give it and where to
save it. You should save it on a different drive/partition
from the one you are migrating, or on an external hard
drive. You can give it any name you want. I called mine
“upgrade.”
Now, PCmover creates the Moving Van, the file that contains all the info to be migrated and saves it where you
specified. This may be quite a large file. Mine was over 7
MB.

I found this migration assistant to be easy to use and quite
effective to migrate applications and files
• About: PCmover
• Vendor: Laplink
• www.laplink.com
• Price: Ranges from $20 to $60 for a single license
This article has been obtained from APCUG with the author’s permission for publication by APCUG member
groups; all other uses require the permission of the author
(see e-mail address above). :

Now you upgrade to Windows 7 by selecting the Custom
method. This will take a while, but your input will not be
needed. Once complete, you reinstall PCmover on the upgraded computer, run it, find the Moving Van file and let
PCmover migrate your applications and data. This transfer
may take quite a while.
When completed, you should have all your applications and
data that you wanted migrated available and working in
Windows 7. There may be some of your applications that
do not work in Windows 7. I had a few, but the problem
was with Windows 7, not PCmover.
Continued above right
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Mac Tips

Ernie Cox, Jr. (Ecoxjr (at) cox.net), Computer Club of Green Valley, Arizona (http://gvcc.apcug.org)
Mac New Administrator Password
On a Mac computer, over time you may get tired of using
the “Admin Password” and want to change to a new one.
Go to System Preferences and click on “ACCOUNTS.” An
“Accounts” window will drop down. Click on the lock at
the bottom left hand side of the window. You must know
the old password to open the lock. When the lock opens,
click on the name with “Admin” under it. Next click on
“Password.” Just to the right is “Change Password,” click
there.

Click on the old name with Admin and then click on the
minus sign to delete the old name Admin. From there, you
will log out and then log back into the new name Admin.
Quick General Mac Tips
Forgot your admin password? Dig up your OS X install
disk and insert it into your Mac drive. Restart your Mac,
while holding down the “C” key. Select your lingo. In the
menu bar, select “Utilities” and then select “Reset
Password.” Be sure to follow the directions, and you will be
in business.

A window will drop down for you to fill in the current pass- Perhaps your DVD or CD is stuck in the drive and won’t
word and new password. You must know the old password come out after pushing the “eject” button. Try holding
down the “E” key and “Command/Apple” key to eject the
and verify the new password after writing it in.
disc. If that doesn’t work, shut down the computer, restart
Click on the words “Change Password,” a window will
and hold down the “Ejection” key, (top right) on startup of
drop down telling you that the password will be changed. If your computer.
you want to change the administrator name along with the
password, you will have to log out of the old name and then Changing colors and size of a photo can be done in either
iPhoto or Preview. These programs are good for beginners
log into the new name on start-up to use the new account.
and for people who don’t have higher-grade programs.
Once you have done the new log in, you must go to the My Preview can be used to put titles, type and other art into
Account column. At the bottom are plus and minus signs.
your pictures.
Continued on page 11
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Mac Tips, continued
If you are having trouble sending large files (10, 12, 15
MB size), you might try using a program called
“YouSendIt” (www.yousendit.com). It’s free for the first 2 GB.
Apple Mail Tips
1. You can mail someone a photo by firing up iPhoto and
either dragging the selected image into Mail, or using
iPhoto’s Share > Email command. But there’s quicker, easier way that bypasses iPhoto. In Mail, choose Window >
Photo Browser. A floating window will appear instantly,
showing the complete contents of your iPhoto library. Find
the picture you want, drag it into a message window, and
you’re done.
2. If you receive mail in “plain text,” you can decide what
font, size, style and color the messages will use. You can
extend the same courtesy to others. Mail uses “Rich Text”
by default for outgoing messages, but you can change this
by choosing Mail > Preferences, clicking the Composing
icon on the toolbar, and then choosing Plain Text from the
Message Format menu. (To change the format for an individual message, choose Format > Make Rich Text, or
Format > Make Plain Text.)
3. If you encounter problems sending or receiving mail,
you can find out exactly what’s wrong by choosing Window > Connection Doctor. Mail will check each of your
incoming and outgoing account connections, and display a

window with a plain-English description of any problems
found, usually with advice for fixing them.
4. If you sent a message to multiple email addresses, and
later realized you forgot to include someone, you don’t
have to go to the trouble of opening the message in your
Sent mailbox, copying its contents, and then pasting the
text into a new message. Instead, select the message,
choose Message > Send Again, and replace the existing
recipients with the new one(s). The subject and message
contents remain the same as before, although they can be
edited if you like.
5. Attachments in messages you’ve received or in copies of
outgoing messages in your Sent mailbox can eat up a lot of
disk space. For IMAP or Exchange accounts that impose a
storage quota this can be a significant worry. Mail can remove attachments from stored messages. If you’ve already
saved a copy of the attachments elsewhere, using this feature is a good idea.
Locate one or more messages with attachments and choose
Message > Remove Attachments. Behind the scenes, Mail
duplicates the message (omitting attachments) and deletes
the original one.
Back-up
It’s a smart idea to make a backup of important software
discs, like those for your personal use (for example Mac OS
X and extra applications discs). With the disc in your

Continued above right
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optical drive, open Disk Utility. Then click the disc’s name
in the list on the left (one level below your optical drive),
and click the New Image button. A dialog appears where
you can name your disk image and choose where it’s saved.
In the dropdown for Image Format, choose DVD/CD Master.
Click Save, and Disk Utility will create a disk image that
ends with a .cdr extension. This is an exact copy of the optical disc in your drive, so you can double-click the image to
mount it, and it’s just like you’ve mounted the disc itself.
To burn a copy of the disk image to another optical disc,
open Disk Utility, click the Burn button, navigate to the
disk image you just created, and click Burn.

This article has been obtained from APCUG with the author’s permission for publication by APCUG member
groups; all other uses require the permission of the author
(see e-mail address above). :

Bing — How’s It Doing?

Linda Gonse, Orange County PC Users Group

Google is one of the smartest, most innovative companies
in the world, but in its core business — online search — it’s
being routinely shown up by Microsoft’s third-place search
engine, Bing.
Bing is a surprisingly fast-moving, innovative product —
Computer Backups
and it’s forcing Google to play catch-up time and time
You never know when you might lose some of that good
again. For all of Bing’s new ideas, it hasn’t translated into
stuff on your computer and need to restore it. So, back it up. big gains in users. The latest numbers from comScore show
There are a number of ways to back up your computer, sev- that 63 percent of searches in the U.S. are performed on
eral of which have been written about many times: Time
Google, but just 13 percent are done on Bing. (Source:
Machine, external hard drives, websites and Apple’s MoCNN.com, http:// bit.ly/adxP61 August 2, 2010, by Jay Yarow,
bile Me. Now there’s another way—your iPhone/iPad/iPod Business Insider)
[device]. There’s an application [app] named Phone View
Bing still handles a small slice of Web searches in the
that can be purchased for $20. Phone View can let you use
United States, 12.7 percent in June, compared with
your device as an external drive for storing files. Then
Phone View makes it easy to search your device and trans- Google’s 62.6 percent, as measured by comScore, the Web
analytics firm. But Bing’s share has been growing, as has
fer any piece of info back onto your computer should
Yahoo’s, while Google’s has been shrinking. (Source:
something be lost or accidentally deleted from your
nytimes.com, http://nyti.ms/ bqBtST August 1, 2010, by Claire
computer. The pictures will be smaller than originals beCain Miller and Ashlee Vance, New York Times) :
cause iTunes makes them smaller for the device.
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35th Anniversary Newsletter CD Now On Sale

Handbrake

Beta .09
Release

Transform DVD to MPEG
Orange County IBM PC Users’ Group

$8.00, includes
postage

HandBrake 0.9.4 is an open-source, GPL-licensed,
multiplatform, multithreaded video transcoder, available for
MacOS X, Linux and Windows.

$7.00 if you
pick it up at a
meeting

HandBrake is a video transcoder that takes your movies and
transfers them to a format that’s useful on your computers,
media centers, and portable electronic devices. It converts
most any video formats to a handful of modern ones.

There’s an old proverb in the video encoding world:
“Speed, size, quality: pick two.” It means that you always have to make a trade-off between the time it takes
to encode a video, the amount of compression used, and
the picture quality. Well, this release of HandBrake refuses to compromise. It picks all three.
http://handbrake.fr/downloads.php

Get yours
today!

Back Issues Still Needed
Our collection remains incomplete. Below is a list of
missing newsletters. Anyone who lends us one of
these (or supplies a good clear copy) will receive the
next CD as our thanks.
1975: #2 and #3 (dates uncertain)
1976: January
1984: August
1985: June, July, August, September. :

SIG News
C/C++ Programming

Mobile Devices

http://www.blast.net/barnold

Brenda Bell (mobdevsig@acgnj.org)

Bruce Arnold (barnold@blast.net)
This is a forum for discussion of programming in general,
beginning and intermediate level C, C++, C-Win programming, hardware, algorithms, and operating systems. We
demonstrate real programming in a non-intimidating way,
presenting complete code for working programs in 3-5
sheets of paper. Sample code is posted on our Web page
after each demonstration.
January: HostShell - A Shell Program to Manipulate the
HOSTS Virus and Spyware Protection. Object: To provide
extra user features for the HOSTS file obtained from
http://www.mvps.org/winhelp2002/hosts.htm

The HOSTS file is part of the Internet software on all computers, but the standard file provides no extra protection.
From Wikipedia: Specially crafted entries in the hosts file
may be used to block online advertising, or the domains of
known malicious resources and servers that contain
spyware, adware, and other malware. The above web site
provides a system that blocks approximately 20,000 bad
web sites.
For details and sample code, visit our Website. Our next
meeting February 15. :
Page 12

The Mobile Devices SIG meets the second Wednesday of
alternate months, 7:30PM at SPRS in Scotch Plains, NJ.
The Mobile Devices SIG focuses largely on curent-generation cellphones and smartphones (such as Blackberry,
Android, iPhone) which bridge the gap between basic cell
phones and traditional computers, and how they can help
you manage and organize your life.
Our membership ranges from those who have recently acquired their first, basic cellphone to those who develop
applications for today’s modern smartphones, iPods, and
ultraportable computers. While we expect to spend much of
our time investigating the built-in features and specialized
applications available to modern smartphones, if you bring
your basic (or multimedia) cell phone, iPod, or other mobile
device with questions on how to use it, where to find applications, or what features they have, we are always happy to
help! Meet and greet and plan where this event goes. Bring
all your ideas, PDAa, fancy phones, etc. Our next meeting
February 9. :
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SIG News, continued
Layman’s Forum

Web Dev

Matt Skoda (som359@aol.com)

Evan Willliams (ewilliams@collaboron.com)

http://www.acgnj.org/groups/laymans.html

This SIG is an open forum for all Website Development
techniques and technologies, to encourage study and development of web sites of all kinds. All languages will be
considered and examined. The current project is a CMS for
the club. Anyone interested in starting a new project, come
to the meeting and announce / explain. Provide as much
detail as possible. WebDev should be an all-encompasing
FireFox Activity
development and examination forum for all issues, applicaFirefox@acgnj.org
tions, OS, languages and systems one can use to build
Websites. We currently have two Web dev languages .NET
This SIG is intended to be an open forum for all FireFox
and Java as SIGs but other langages and OS need to be inand Mozilla techniques and technologies, to encourage
vestigated, examined and tested; Windows, Linux, UNIX,
study and development of web sites of all kinds. All brows- DEC, Vax, HP etc. Intel-PC, Motorola - MAC etc. Our
ers will be considered and examined. All are encouraged to next meeting March 9. :
“think out of the box” about new web site design. All members and guests are invited to check out the design concepts
Java
and voice their opinion. Next meeting, February 21.:
Mike Redlich (mike@redlich.net) http://www.javasig.org

We meet on the second Monday of the month (no meetings
in July and August) to discuss issues of interest to
noviceusers or those who are planning to get started in
computing. Watch our Web page for updates and
announcements. :

NJ Gamers

Gregg McCarthy (greggmajestic@gmail.com)
http://www.NJGamers.com
www.lanparty.com

The next Friday Night Frag will be February 11, 6 p.m.
to Saturday 12 noon — 18 hours for 5 bucks!
BYOC - Bring your own computer
BYOF - Bring your own food.
and if you don't like sitting on metal chairs... BYO chair!:

February 8: Android 101 — This month's meeting will
feature Barry Burd providing a technical overview of Android. This presentation will cover fundamentals of the
Android operating system, the app development lifecycle,
and tools you can use to publish your app. We’ll cover everything from Cupcake (Android 1.5) to Gingerbread (the
brand-new Android 2.3) and beyond. :

Hardware Activity

Window Pains

Mike Reagan (hardware@acgnj.org)
This group is dedicated to repairing, refurbishing and/or recycling older computers. Ten people attended the first
meeting of the ACGNJ Hardware Activity; so there is still a
market for this type of event. One guy came all the way
from the Bronx! Although we looked at some of the older
equipment stored in the back room, most of our time was
spent in talking about past experiences and planning for the
future. Hopefully, we can establish a viable long-term
schedule of projects, and keep the interest of those who attended this inaugural meeting. If you have a hardware
problem, bring it in and we can all help fix or demolish it.
(no guarantees either way)
Next meeting February 24 :

http://www.acgnj.org/groups/winpains.html

Jim Cooper (jim@thecoopers.org)

LUNICS (Linux/Unix)

Andreas Meyer (lunics@acgnj.org)

http//www.acgnj.org/groups/lunics.html

LUNICS is a group for those who share an interest in Unix
and similar operating systems. While we do quite a bit with
Linux, we’ve also been known to discuss Solaris and BSD
as well. We meet on the first Monday of the month at the
Scotch Plains Rescue Squad. See the web page for
directions and more information.
Our next meetings, February 7, March 7 :
John Raff (jraff@comcast.net)

Investment Software

Our intent is to provide members with Windows oriented
application discussions, Microsoft and Linux style. Presentation to be directed to more heavy technological level of
attendee, although newbies are welcomed.
February 18 : Donald McBide on Web TV :

Main Meeting
http://www.acgnj.org/groups/mainmeet.html

Mike Redlich (mike@redlich.net)
February 4: Bob Hawes on FSF Compliant GNU/Linux
Distributions. :
February 2011

http://www.acgnj.org/groups/sig_investment.html

The Investment SIG continues with presentations on how to
use analysis programs TC2000 and TCNet. Large charts are
presented on our pull down screen and illustrate the
application of computer scans and formulas to find stocks
for profitable investments. Technical analysis determines
buy points, sell points and projected moves. Technical analysis can also be used on fundamentals such as earnings,
sales growth, etc. We're no longer focusing on just
Telechart -- if you are using (or interested in) Tradestation,
eSignal, VectorVest -- or just in learning how to select and
use charting and technical analysis, come join us !!
Our next meetings: February 10. :
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Guru Corner

Discount Computer Magazine Price List

If you need help with any of the technologies listed below,
you can call on the person listed. Please be considerate and
call before 10 PM.

As described by the DealsGuy

Software

HTML

Mike Redlich

908-246-0410

Jo-Anne Head

908-769-7385

ColdFusion

Jo-Anne Head

908-769-7385

CSS

Frank Warren

908-756-1681

Jo-Anne Head

908-769-7385

Java

Mike Redlich

908-246-0410

C++

Bruce Arnold

908-735-7898

Mike Redlich

908-246-0410

ASP

Mike Redlich

908-246-0410

Perl

John Raff

973-560-9070

Frank Warren

908-756-1681

XML

Mike Redlich

908-246-0410

Genealogy

Frank Warren

908-756-1681

Home Automation Frank Warren

908-756-1681

Operating Systems
Windows 3.1

Page 14

Ted Martin

732-636-1942

1 yr
2 yr 3 yr
Computer Games
$10.95
20.95 29.95
Computer Gaming World
14.95
28.95 41.95
Computer Shopper1
16.97
32.95 47.95
Dr. Dobbs Journal
15.95
30.95
Mac Addict
10.97
Mac Home Journal
15.97
29.97
Mac World
12.95
Maximum PC
9.95
18.95 27.95
Microsoft System Journal
21.95
39.95
PC Gamer
12.95
48.95 68.95
PC Magazine (22/44/66 Issues) 25.97
PC World
16.95
Wired
6.00
12.00 17.00
These prices are for new subscriptions and renewals. All
orders must be accompanied by a check, cash or Money
Order. Make payable to Herb Goodman, and mail to:

Herb Goodman, 8295 Sunlake Drive, Boca Raton,
FL 33496
Telephone: 561-488-4465, e-mail: hgoodman@prodigy.net
Please allow 10 to 12 weeks for your magazines to start.
For renewals you must supply an address label from your
present subscription to insure the correct start of your renewal. As an extra service I will mail a renewal notice
about 4 months prior to their expiration date. I carry more
than 300 titles at excellent prices — email for prices. :
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Other Local Computer Groups

Princeton Macintosh User Group: 7:15 pm 2nd
Tuesday, Jadwin Hall, A-10, Washington Rd,
Princeton, (609) 252-1163, www.pmug-nj.org

Linux Users Group in Princeton: 7 pm, 2nd
Wednesday, Lawrence Branch Mercer Library,
Rt#1 & Darrah Lane, Lawrence NJ

New York PC: 3rd Thurs, 7 pm, PS 41, 116 W
11th St. For info call hotline, (212) 533-NYPC,

Computer Education Society of Philadelphia:
Meetings & Workshops at Jem Electronics, 6622
Castor Ave, Philadelphia PA. www.cesop.org/

Brookdale Computer Users Group: 7 pm,3rd
Friday, Brookdale Community College, Bldg
MAN Rm 103, Lincroft NJ. (732)-739-9633.

NJ Macintosh User Group: 8 pm, 3rd Tuesday,
Allwood Branch Library, Lyall Rd, Clifton NJ.
(201) 893-5274 http://www.njmug.org.

http://www.lugip.org

www.bcug.com

PC User Group of So. Jersey: 2nd Mon., 7 pm,
Trinity Presb. Church, 499 Rt 70 E, Cherry Hill,
NJ. L. Horn, (856) 983-5360

Hunterdon Computer Club: 8:30 am, 3rd Sat,
Hunterdon Medical Center, Rt 31, Flemington NJ.
www.hunterdoncomputerclub.org, (908)
995-4042.
http://www.pcugsj.org
Morris Micro Computer Club: 7 pm 2nd Thurs., Central Jersey Computer Club: 8 pm, 4th FriMorris County Library, Hanover Ave, Morristown day, Rm 74, Armstrong Hall, College of NJ. Rich
NJ, (973) 267-0871.
Williams, (609) 466-0909.

http://www.morrismicro.com

Philadelphia Area Computer Society: 3rd Sat, 12 NJ Computer Club: 6:15 pm, 2nd Wednesday exnoon Main Meeting, groups 8 am-3 pm. Upper
cept Jul & Aug, North Branch Reformed Church,
Moreland Middle School, Hatboro PA. (215)
203 Rt 28, Bridgewater NJ. http://www.njcc.org
764-6338. www.pacsnet.org

Classified
FREE TO MEMBERS. Use our clas-

sified ads to sell off your surplus computer
stuff. Send copy to Classified, ACGNJ
NEWS, P.O. Box 135, Scotch Plains NJ
07076 or e-mail to the editor,
bdegroot@ptd.net. Classified ads are free
to members, one per issue. Non-members
pay $10. Send check payable to ACGNJ
Inc. with copy. Reasonable length, please.

http://www.nypc.org

NY Amateur Computer Group: 2nd Thurs, 7
pm, Rm 806 Silver Bldg, NYU, 32 Waverly Pl,
NYC. http://www.nyacc.org
NJ PC User Group: 2nd Thurs, Monroe Rm at
Wyckoff Public Library, 7 pm. Maureen Shannon,
(201) 853-7432, www.njpcug.org
Princeton PC Users Group: 2nd Monday,
Lawrenceville Library, Alt Rt 1 & Darrah Lane,
Lawrenceville, Paul Kurivchack (908) 218-0778,

http://www.ppcug-nj.org

Radio and TV Programs
Computer Radio Show, WBAI
99.5 FM, NY, Wed. 8-9 p.m.
Software
Review,
The
Learning Channel, Saturday
10-10:30 p.m.
On Computers, WCTC 1450
AM, New Brunswick, Sunday
1-4 p.m. To ask questions call
(800) 677-0874.
PC Talk, Sunday from 8 p.m. to
10 p.m., 1210 AM Philadelphia.
1800-876-WPEN, Webcast
at http://www.pctalkweb.net.

http://www.apcug.net

Directions to Meetings at Scotch Plains Rescue Squad, 1916 Bartle Ave., Scotch Plains NJ
From New York City or Northern New Jersey

Take Route 1&9 or the Garden State Parkway to US 22 Westbound.

From US 22 Westbound

Exit at Park Avenue, Scotch Plains after McDonalds on the right,
diagonally opposite Scotchwood Diner on the left, immediately
From Southern New Jersey
before the overpass. After exiting, turn left at the light and use
Take Parkway north to Exit 135 (Clark). Stay on left of ramp, fol- overpass to cross US 22. Bear right at bottom of ramp to continue
low circle under Parkway. Bear right to Central Avenue; follow to south on Park Avenue. Turn left at the second light (a staggered
Westfield and under RR overpass. Left at light to North Avenue; intersection). Scotch Plains Rescue Squad (2-story brick) is on the
right. Do not park in the row next to the building — you’ll be
follow to light in Fanwood. Right on Martine (which becomes
towed. We meet on the second floor, entering by the door at the
Park Ave). Right on Bartle Ave in middle of shopping district.Scotch Plains Rescue Squad (2-story brick) is located on the right front of the building.
right. Do not park in the row next to the building — you’ll be
From Western New Jersey
towed.

From I-78 (either direction)

Take US 22 Eastbound to the Park Avenue exit. The exit is about
Take exit 41 (Scotch Plains); follow signs to US 22. Turn right at a mile past Terrill Road and immediately past the overpass. Exit
light at bottom of hill and use overpass to cross Rt. 22. Follow US onto Park Avenue South and follow the directions above to the
Rescue Squad building. :
22 Westbound directions.
February 2011
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Premiere Elements 8

Louise Maye Huddelston (editor (at) hal-pc.org), HAL-PC (www.hal-pc.org)
Premiere Elements 8 is the companion software to
Photoshop Elements 8, — this is the video editor and
“movie-maker” software. If you like to take videos or make
slide shows with effects, music and more advanced direction, this is what you need. You can buy Premiere bundled
with Elements or separately. This review is about Elements.
Premiere 8 has serious problems that have been traced to
conflicts with Realtek Audio drivers and Nvidia graphics
driver installation software. Suggestion: download the free
30 day trial version to test compatibility with your PC.
I am having an issue with some of the rendering and converting to certain formats while I can render and upload to
YouTube. The troubleshooting is a complex series of tests
and definitely pushing my patience, as it will probably take
me more than a few hours.
I found this software absolutely intuitive and even as a total
novice to video production, I made several A/V productions
and I was very happy. Not perfect, but I could to do some
cool things with sound and transitions that were beyond my
usual slideshows with Photoshop Elements. There is Instant
Movies, to process a video clip for you with pre-packaged
templates, based on one of several themes — a life-saver.
Auto Analysis is a new feature that takes in image content
(including face recognition) and allows you to do Smart
Tagging of various aspects, including video quality, date,
subject and much more.
Help: As far as help goes, the tutorials are somewhat limited unless you pay for the Plus Membership. There is
excellent help online and I had occasion to use it.

Remark: I have heard that some users have crashes,
freezes, etc. I think this is not so much the program but the
user’s computer resources – mediocre operator, insufficient
RAM and/or CPU speed.
I expected that I would be able burn a DVD in the AVCHD
format and then play it on a Blu-Ray player. I discovered
that Premier Elements 8 does not support burning AVCHD
format DVDs! Most competitive software will burn
AVCHD format DVDs. More successful results from
Microsoft’s Movie Maker Live, which is free.
Another cool technology from Adobe stable in Premiere 8
is “Object Tracking”. You have to use it to believe it! You
select a person/moving object in the video & drop a clip
(rain, lightening, bird etc) on the object.
General: Contacting Adobe support is another exercise in
patience. Send them an e-mail, wait 2-3 days for a response
is canned, wait another 2-3 days for another response. If
you’re in any kind of hurry, forget it. Adobe support just isn’t the quality it used to be. Bottom line, for the money
Premiere is the best video editor I have tried.
The practical value of Premiere 8 is the incredibly rich feature set, the sophisticated, yet simple user interface, and the
wealth of content, add-ons, and tutorials. Just put it in a sufficiently powerful engine!
This article has been obtained from APCUG with the author’s permission for publication by APCUG member
groups; all other uses require the permission of the author
(see e-mail address above). :

ACGNJ MEETINGS
For the very latest news on ACGNJ meetings visit the ACGNJ Web Page (http://www.acgnj.org)
Tuesday, February 1

Tuesday, February 15

7 P.M. - Board of Directors meeting.

Friday, February 4

7:30 P.M. - C/C++ Users, Bruce Arnold (barnold@ieee.org),
908-735-7898

Monday, February 7

8 P.M. - Window Pains, John Raff (john@jraff.com).

Tuesday, February 8

7 P.M. - Firefox Activity, David McRitchie (firefox@acgnj.org)

8 P.M. - Main Meeting, Paul Syers (paul.syers@acgnj.org).

Friday, February 18

8 P.M. - Lunics, Andreas Meyer (lunics@acgnj.org)

Monday, February 21

7:30 P.M. - Java, Mike Redlich (mike@redlich.net)
908-246-0410.

Thursday, February 24

8 P.M. - Hardware, Mike Reagan (hardware@acgnj.org)

Wednesday, February 9

Tuesday, March 1

7:30 P.M. -WebDev, (webdev@acgnj.org)

7 P.M. - Board of Directors meeting.

Thursday, February 10

Friday, March 4

8 P.M. - Investing, Jim Cooper (jim@thecoopers.org).

8 P.M. - Main Meeting, Paul Syers (paul.syers@acgnj.org).

Friday, February 11

Monday, March 7

6 P.M. to 5 A.M.- NJ Gamers. Gregg McCarthy
(greggmc@optonline.net), 732-721-6507. Break 8 to 10 P.M.

8 P.M. - Lunics, Andreas Meyer (lunics@acgnj.org)

8 P.M. - Layman’s Forum, Matt Skoda (som359@aol.com),
908-359-8842.

7:30 P.M. - Mobile Devices, Brenda Bell (mobdevsig@acgnj.org)
:

Monday, February 14

Wednesday, March 9

All meetings, unless otherwise noted, are at Scotch Plains Rescue Squad, 1916 Bartle Ave., Scotch Plains, N.J.
Directions and map inside back cover.
Page 16

ACGNJ News

February 2011

